
STM32 & SCILAB

Readme
Rev 1.1



Table of Contents
Title Page

Objectives 3

Systems Check 4

Hardware setup 8

Software setup 12

Tools usage 14

Installation 15

Xcos application example 26

Build Application flow 48

Run project 50

Diagram code variation 57

2

Must be read Recommended reading Detailed



Objectives

• Hands-on workshop to show you the steps needed to 
quickly develop STM32 graphical applications using 
SCILAB XCos environment.

• Know tools installations and settings to be able to start 
development.

• Know « C » Code Generation possibility

• Know how to develop application from scratch

• Know where to obtain additional technical support
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Systems Check
• Mandatory Software

• From SCILAB
• SCILAB Xcos version 5.5.2

• From STMicroelectronics
• STM32CubeMX 

• One of following Toolchain
• EWARM from IAR
• MDK-ARM from Keil
• TrueSTUDIO from Atollic
• SW4STM32 from STMicroelectronics

• STM32-SCILAB toolkit to develop STM32 applications 

• Hardware
• Any electronic application board with STM32 and SWD/JTAG connection. 

• STLink or 3rd parties dongle if not integrated to STM32 application board.
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Pre-requisites



Pre-requisites
• STM32CubeMX

• Have a look to STM32CubeMX videos to know how 
using this powerfull tool.
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Lasts 9 minutes and 12 seconds Lasts 6 minutes and 44 seconds



Pre-requisites
• Toolchain

• You must be confortable with one of following
toolchain.

• Ewarm from IAR

• µVision from Keil

• TrueSTUDIO from Atollic

• SW4STM32 from ST
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Embedded Workbench for Arm (Ewarm)



Hardware setup



Step #1 – Hardware selection

• Use one of STM32 boards including STLink
• Nucleo, Discovery, EvaluationBoard etc…
• STM32F3348-DISCO and STM32F429i-DISCO 

will be used during examples.

• Or STM32 application board connected to SWD (Single 
Wire Debug)/JTAG dongle.

• STLink, ULink2, JLink etc..
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Nucleo Board Discovery Board Evaluation Board

STLink ULink2 JLink



Step #2 – Hardware connection

• Connect USB dongle port to PC USB port
• And connect STM32 HE10 20 pins dongle connector to STM32 target board

• Or connect PC USB port to embedded STLink
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Exemple: Connect STLink
dongle USB to PC on one side.

Exemple: 
Connect HE10 20 pins STLink dongle connector
to HE10 20 pins connector of 
STM32 Evaluation Board on the other side.

Exemple: Connect USB PC port to STLink USB port embedded in 
STM32 board. 

Usually, all ST recent boards embedd
STLink tool. 



Step #3 – Hardware connection

• As soon as you are using ST-LINK
• look at 

http://www.st.com/web/catalog/tools/FM146/CL1984/SC720/SS1450/PF251168?s_
searchtype=partnumber

• « Related Tools and Software » section to check or update firmware
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Software setup



Quick description of tools 13

XCos

SCILAB

Graphical development environment
for simulation 

High level language for complex 
calculation

STM32Cube
Embedded
Software

Collection of embedded 
software components, highly 
portable from one STM32 to 
another

STM32CubeMX

Configuration software tool 
on the PC, able to generate 
initialization C code versus 
user choices

One toolchain from partners or 
ST is required to compile and 
link C code generated by 
SCILAB, STM32CubeMX and 
STM32Cube embedded software

Toolchain



Tools usage

• Code Generation for STM32
• Data (input or output) obtained within STM32 through its peripherals (ADC, Timers, …) 

and algorithm fully executed on STM32. 

• Code generated from Xcos diagram.

• Needed tools: SCILAB/Xcos, STM32CubeMX, one of supported toolchains and 
STM32 toolbox for SCILAB must have been installed.
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STM32Cube
Embedded
Software

STM32CubeMX

SCILAB/
Xcos Toolchain

Core ADC

TIM

I2C



Step #1 – Software installation

• Install SCILAB 5.5.2 software
• SCILAB/Xcos is mandatory

• http://www.scilab.org

• Install STM32CubeMX 
• Download and documents available from : www.st.com/microxplorer

• Install toolchain (Cf Slide 4 : « Systems Check ») 
• Cf Slide 3 « Systems Check » to get link to supported 3rd parties 

download area.  
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Step #2 – Software installation

• Install STM32 for SCILAB
• This toolkit is mandatory to be able to design Xcos graphical application for STM32.

• Set ATOMS Config Proxy and Network parameters to download using 
atomsGui() command

• atomsSetConfig(‘parameter’,’value’) for parameters :
• useProxy , proxyHost, proxyPort, proxyUser, proxyPassword and offline

• Or download from https://atoms.scilab.org/ (Xcos or Real-Time) and enter 
the install command to install xcos_stm32_toolbox 

• STM32 is available from Xcos diagram

• Functionalities have been added to the « Tools » menu :
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Step #4 – STM32 for SCILAB integration

• STM32 Help document available for SCILAB
1. Enter help from Scilab 5.5.2 Console

2. Help Browser window opens
1. STM32 dedicated Help is available

17

Help regarding STM32 
functionalities



Step #4 – STM32 for SCILAB integration

• STM32 Palette for STM32 peripherals integrated to 
Palette browser

1. Available drivers:
• GPIO

• Read, Write, External Interrupt

• USART
• Send, Receive

• TIMER
• Output PWM,

• ADC
• Read

• DAC
• Write
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Look at release note for restrictions and 
not supported functionalities.



Xcos diagram setting



Xcos diagram Setting 1/5

• Enter xcos command from Scilab 5.5.2 Console or click xcos icon .

• Then new xcos diagram is opened
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Xcos diagram Setting 2/5

• Tools tab gives possibility to :

1. Select .ioc file.
• Ioc file is STM32 configuration done using STM32CubeMX . (cf slide 6)

2. Generate C code for this diagram.
• Based on STM32 HAL C code libraries

3. Generate project for this diagram.
• STM32CubeMX generates project for the selected toolchain. 
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Toolchain is selected from STM32CubeMx 
Project settings (Alt+P).



Xcos diagram Setting 3/5

• Save diagram :
• C:\Users\xx\AppData\Roaming\Scilab\scilab-5.5.2\ « diagramName.conf » contains informations about 

STM32 used and ioc file (path and name) attached to the diagram.
• This file is created when you attach an ioc file to diagram from « Tools > IOC File Select »
• It is better to save the file before selecting the ioc.

• Example: 
1. Save diagram as ScilabForSTM32.zcos
2. Select « IOC File Select »
3. Get Ioc File window opens
4. Push IOC File Select button.
5. Browser opens
6. Select an ioc file
7. Push OK button
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• ioc file is generated from
STM32CubeMx  tool.

• It contains STM32 configuration 
(hardware and peripherals settings) 
used for the diagram.

• See following Xcos application 
example for details.



Xcos diagram Setting 4/5

• IOC file MUST be selected every time diagram is opened
• Selected IOC Name and Selected IOC Path are automatically updated with parameters saved in 

C:\Users\xx\AppData\Roaming\Scilab\scilab-5.5.2\« DiagramName.conf »  

• Example: 
1. Diagram saved as ScilabForSTM32.zcos
2. Select « IOC File Select »
3. Selected IOC Name and Selected IOC Path
Are updated with parameters from:

ScilabForSTM32.conf file contents:

1. Ioc file name
2. Ioc file path
3. STM32 family
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AppData\Roaming\Scilab\scilab-5.5.2\ScilabForSTM32.conf

• Convention : Same name for ioc file and its repository.



Xcos diagram Setting 5/5

• Generate Code and Generate Project 

Cf slides:
code generation
and 
project generation
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Xcos application example
• Hardware :

• Example based on STM32F3348-DISCO
• Configuration :

• Leds (LED3/4/5/6)
• Push Button (User blue button)
• USART2 Virtual Com Port (SB14&SB16 soldered)
• ADC1
• TIM1 & TIM6 
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• Software application :
• Use TIM1 to blink LED3 at 1Hz 
• Use TIM6 to blink LED4 at 2Hz
• Use TIM6 to trig ADC1 channels 2&3 conversion
• Blink Led6 when user push button is pressed
• Send ADC1 channel 3 values on USART2 when user push button is pressed



STM32CubeMX STM32F3348 Pinout

• Hardware pinout configuration
• PA0 : GPIO_EXTI0
• PA1 : ADC1_IN1
• PA2 : ADC1_IN2
• PB3 : Usart2_Tx
• PB4 : Usart2_Rx
• PB6 to PB9 : GPIO_Output
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• Hardware setting
• USART2 is Asynchronous

• ADC1 IN2 & IN3 Single-ended

• TIM1 Channel1 as Ouput Compare No output

• TIM6 Activated (No Output)



STM32CubeMX Peripheral settings 1/2 27

• Peripheral configuration :
• USART2

• Baud Rate : 115200
• Word Length: 8 Bits
• Parity: None
• Stop Bits: 1
• Enable global interrupt

• ADC1
• Injected Channels 2&3 
• Interrupt at end of sequence of conversion
• Conversion triggered from Timer6
• Interrupt Enabled



STM32CubeMX Peripheral settings 2/2 28

• Peripheral configuration :
• TIM1

• Default configuration
• TIM1 Update interrupt enabled

• TIM6
• Trigger event :Update Event 
• TIM6 global interrupt enabled

• GPIO External interrupt
• External Interrupt Mode with

Falling edge trigger detection



STM32CubeMX Clock Configuration 29

• Clock Default Configuration:
• 16 MHz

• Modification not mandatory
• Can be 36 MHz for example



STM32CubeMX project Settings 30

• Project Name:
• «test» for this example

• Project Location :
• C:\TEMP for this example

• Save the current project
• test.ioc file is available from

c:\TEMP\test repository

• You can save ioc file anywhere but
• It is preferable to save ioc file in 

same repository as diagram that will
use it. Repository and ioc file must 
have same name. 



STM32CubeMX project Settings 31

• Project Name:
• «test» for this example

• Project Location :
• C:\TEMP for this example

• Save the current project
• test.ioc file is available from

c:\TEMP\test repository

• Generated code is based on STM32 HAL C 
librairies.

• It is automatically downloaded/updated if it is
necessary.



Xcos diagram creation

• Open new xcos diagram from Scilab 5.5.2.

• Save xcos diagram as C:\Temp\test\STM32F3348DISCO.zcos 

• Link diagram to  previously saved C:\Temp\test\test.ioc file 
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Tools > IOC File Select



USE TIM1 to Blink LED3 at 1Hz 33

• Software application example:

• Use TIM1 to blink LED3 at 1Hz 

• Use TIM6 to blink LED4 at 2Hz

• Use TIM6 to trig ADC1 channels 2&3 conversion

• Blink Led6 when user push button is pressed

• Send ADC1 channel 3 values on USART2 when user push button is pressed



TIM1 Selection & Configuration 34

• Palette browser
• Select View>Palette browser if it is not visible

• TIM1 Selection
• Drag&Drop TIMER block from Palette browser

• TIM1 Configuration
• Open (double click) TIMER block parameters window
• Select TIM1 and set parameters.

• Prescaler must be set with constraint
that ARR max value is 65535 
regarding needed output channel
frequency.

TIM1

Prescaler or 
Timer Clock

1Hz for output 
frequency

Validate Update 
interrupt



TIM1 Application 35

• TIM1 toggle LED3 at 1Hz
• Drag&Drop GPIO_Write block to diagram and open 

(double click) GPIO_Write block parameters.

Connect TIM1 Up output event to 
GPIO_Write input event to blink LED3 
when TIM1 update interrupt occurs. 
Every second at 1Hz

PortB Pin6 
Toggle

Check Input Event Activation.
GPIO_Write block will be activated by 

the connected event

Output Event
Input Event



USE TIM6 to Blink LED4 at 2Hz 36

• Software application example:

• Use TIM1 to blink LED3 at 1Hz 

• Use TIM6 to blink LED4 at 2Hz

• Use TIM6 to trig ADC1 channels 2&3 conversion

• Blink Led6 when user push button is pressed

• Send ADC1 channel 3 values on USART2 when user push button is pressed



TIM6 Application 37

• TIM6 toggle LED4 at 2Hz
• Make the same thing as for TIM1 but frequency is 2Hz 

and PortB Pin8 toggle as it is connected to Led4

Connect TIM6 Up output event to 
GPIO_Write input event to blink LED4 
when TIM6 update interrupt occurs. 
Every 0.5 second at 2Hz



USE TIM6 to trig ADC1 channels 2&3 38

• Software application example:

• Use TIM1 to blink LED3 at 1Hz 

• Use TIM6 to blink LED4 at 2Hz

• Use TIM6 to trig ADC1 channels 2&3 conversion

• Blink Led6 when user push button is pressed

• Send ADC1 channel 3 values on USART2 when user push button is pressed



ADC1 Selection & Configuration 39

• TIM6 is configured to trig ADC1 from STM32CubeMx 
• ADC1 Selection

• Drag&Drop ADC block from Palette Browser and open ADC block 
parameters

• ADC1 Configuration
• We will need ADC Ch3 value, uncheck Injected Rank1 for not 

needed Ch2

• Select JEOC/S as interrupt output trigger
Injected end of 

conversion trigger

ADC1_Read End of Injected Convertion
(JEOC) event is available to trig process

Ch3 value is available as output

Output Event

Data output



ADC1 Application 40

• TIM6 trig ADC1 channels conversion
• Blink LED5 at end of ADC1 conversion to verify that TIM6 

has triggerer it.
• Drag&Drop GPIO_Write block.
• Set GPIO_Write block parameters window to toggle Pin9 

(LED5 is connected to Pin9)

LED5 will blink when ADC1 injected
channels 2&3 has been converted.

Sart of Conversion is triggered from TIM6

Channels 2&3 values are available at the 
end of conversion

PortB Pin9 
Toggle

Check Input Event Activation.
GPIO_Write block will be activated by 

the connected event



Push Button functions 41

• Software application example:

• Use TIM1 to blink LED3 at 1Hz 

• Use TIM6 to blink LED4 at 2Hz

• Use TIM6 to trig ADC1 channels 2&3 conversion

• Blink Led6 when user push button is pressed

• Send ADC1 channel 3 values on USART2 when user push button is pressed



EXTI Selection & Configuration 42

• EXTI0 Selection

• Push Button is connected to External Interrupt 0 on PA0

• External interrupt Event will be generated for action on 
Push Button. 

• Drag&Drop GPIO_Exti block from palette Browser

• Open (double click) GPIO_Exti block parameters window
and select GPIOA pin0

PortA Pin0

External Event on PA0 available
on External Interrupt block.

External Interrupt Event 
Trig LED6 blink & 

USART_Send



Push Button Action 1/2 43

• Blink LED6 
• Drag&Drop GPIO_Write block from palette browser to diagram.
• Open (double click) GPIO_Write block parameters window and 

select Pin7 (LED6 is connected to Pin7)
• Connect GPIOA_Exti0 output event to GPIOB_Write Tgl:7 input 

event. PB7 will blink every button pushed.

• USART2 Settings
• Drag&Drop USART_Send block from Palette Browser and open 

parameters window. Connect GPIOA_Exti0 output event to 
USART2 input event.

PortB Pin7 
Toggle (LED6)

GPIO_Write block will be activated by 
the connected event

It is mandatory to set Buffer Size as close 
as messages sent in order to avoid
memory waste. 

USART2 selected

USART_Send block will be activated
on External event activation.

Buffer size = Maximum message sent size



Push Button Action 2/2 44

• String to send on USART2
• Build string with ADC1 Ch3 value
• ADC1 Ch3 output is 12bits value. It should be converted to 0-3.3V value. Connect converted value to 

« C block 4 » to build string to send.
• Connect ConvToStr block outputs to USART2 Send block.

Output Event

« C block 4 » C function code
Build string to send

Input Event



« C block 4 » configuration 1/2 45

• C function parameter description
• Drag&Drop « C block 4 ».
• It is used to include C code to SCILAB.
• Set « C block 4 » parameters.
• Click OK

Input type = real (double)

Data types:

• 1 real

• 2 complex

• 3 int32

• 4 int16

• 5 int8

• 6 uint32

• 7 uint16

• 8 uint8

Function name

Input = 1 data value

output = 2 data values

output type = uint16 and uint32



« C block 4 » configuration 2/2 46

• C function write
• Write C code application processing input(s) to generate

output(s)
• Click OK.
• « External librairies » not processed for the moment. 

Flag input value:
• -5 Error
• 0 Derivative state
• 1 Output state
• 2 State update
• 3 Output Event Timing
• 4 initialization
• 5 Ending
• 6 Reinitialization
• 7 Continuous property Update
• 9 Zero Crossing
• 10 Jacobian

outputs

input

Initialization

Output update



Build Application flow 47

• Build Xcos Application Process
• Build application has been divided in 2 steps:

• Generate Code
• Generate Project

• Generate Code
• Press « Generate Code » to automatically call stm32BuildProject function that will generate C code for the diagram.

• Generate Project
• Press « Generate Project » to automatically call stm32GenerateProject function.
• It is used to retrieve all C generated files and generate STM32CubeMx command.
• Project is generated from STM32CubeMx depending on project settings parameters.

IOC File Selection is mandatory.
IOC file must have been selected before
generating code / generating project



Generate Code 48

• Code generation flow
• Entry point: stm32BuildProject function.
• The process gives a « flat image » of the diagram, which is a data base of all blocks connections, inputs, outputs, events

etc…
• Then, generated code is Synchronous or Asynchronous.
• Asynchronous code manages interrupts where Synchronous code is called every regular steps.
• Generated code depends on block input event connection.

1. When block input event is connected to an STM32 output event. Generated code is asynchronous (interrupts)
2. When block input event is connected to a Palettes>Event handling block. Generated code is synchronous.
3. When block do not have input event:

• If data flow (input/output connection) including block is connected to a block with input event, cf 1 or 2.
• If data flow do not include any block with input event, Generated code is synchronous. Minus synchonous step time used or default Tick Handler value. (cf help 

STM32_Preferences) 

• Synchronous code
• The process gets all activation clocks and computes STM32 systick value (PGCD or default Tick Handler when diagram do 

not have any clock event)
• A stepi (i= 1…n) function is generated for every activation clock.

• Asynchronous code
• Only STM32 block generates asynchronous code.  Code of blocks connected to an STM32 output event is generated in 

STM32 peripheral HAL interrupt Callback function.
• Then, code will be called every time STM32 peripheral event occurs.  



Generate Project 49

• Project generation flow

• When « Generate Code » is called, .c/.h files are created as well as main.c. 
• Then, STM32CubeMX is called to integrate peripherals initialization to main.c and to generate project including all .c/.h files. 
• Interface files with STM32CubeMX are .mlproject and .script files.

• Generate Project

• Press « Generate Project » to automatically call STM32CubeMx.
• Press « Open Project » to start toolchain.
• Project can be built, downloaded into STM32 target and run or debug. 

« Generate Project » is mandatory every time 
« Generate Code » has been called.

Click « Open Project » to automatically open 
project using selected toolchain.

.mlproject : Contains information about .c/.h files to add to project.

.mxproject : Generated from STM32CubeMX. Contains
information about .c/.h files generated from STM32CubeMX

.script : Contains STM32CubeMX command to generate project.



STM32CubeMX Code Generation 50

• STM32CubeMX project generation
• Project is generated in same repository as ioc

file. (cf « test » project example)
.mlproject : Contains information about .c/.h files to add to project.

.mxproject : Generated from STM32CubeMX. Contains information 
about .c/.h files generated from STM32CubeMX

.script : Contains STM32CubeMX command to generate project.

• STM32CubeMX project contains
• Drivers : Contains STM32 selected library and 

CMSIS files

• EWARM/MDK-ARM: Contains toolchain project
files (For example)

• Inc & Src: Contains STM32CubeMX generated
or modified files. 

• test ( name: Contains all .c/h files generated from
MATLAB®

(IAR)

(KEIL)



Diagram vs Generated Code 51

• Every STM32 peripherals generate initialization code in .c/.h files which name is created using name of the 
diagram and peripheral name. Asynchronous code (interrupts) is generated in "DiagramName"_it.c file and 
Synchronous code is generated in "DiagramName".c file.

main.c : Generated from SCILAB. It has been modified
by STM32CubeMX to add project configuration.  
_hal_msp.c: Peripherals configuration
_it.c : Interrupt handlers for configured interrupt only.



Asynchronous Generated Code 52

• Asynchronous code is generated in xx_it.c file from blocks connected to STM32 event. (XX is name of 
the diagram) 



Synchronous Generated Code 53

• Synchronous code is generated in "DiagramName".c file from blocks connected to « Event Handling » blocks. 
Each Event is associated to a Step function including all code it manages. 

Functions are called twice.
1. Output State (parameter 1)
2. State Update (parameter 2)

• Step functions are scheduled from main depending on « Event Handling » step parameter time or default tick handler step
when there is no « Event Handling » in the diagram. 

Step function is scheduled at default 1ms tick handler
value. (cf preferences)



Toolchain Project 54

• Toolchain settings
• STM32CubeMX has automatically generated project including mandatory

settings. It is exactly same project at it should be generated « by hand ». 
Possibility to tune all settings.

• Toolchain Actions
• Build project
• Start Debug Session (Ctrl+F5)

It is required to know toolchain functionalities.
Keil µVision used here as example

BUILD 
project

Start Debug

STM32 board must be connected to PC 
when you click « Start Debug Session »



Run Project 55

• STM32F3348DISCO example results
• Project is started and waits at 1st main 

instruction. 
• Click «Go»
• LD3/LD4/LD5 are blinking
• LD6 is alternatively ON and OFF when
you press User button. ADC value set on
PA2 (ADC1 Ch3) is sent to PC through
USART. 
You can see ADC value on PC using
PuTTY for example.

It is required to know toolchain functionalities.

Example using µVision (KEIL) toolchain



Diagram and Code variation 1/3 56

• One step function scheduled from « Event Handling »

Step1 function is scheduled at 0.8s



Diagram and Code variation 2/3 57

• Two steps functions scheduled from « Event Handling »

Systick is 0.1s, computed as PGCD of Event Handling periods.
Step1 function is scheduled at 0.8s
Step2 function is scheduled at 0.3s

GPIO Toggle is no more in the Asynchronous 
external interrupt function.



Diagram and Code variation 3/3 58

• No Synchronous function

For this configuration:
1. Step function is scheduled at default 1ms tick

handler value. (cf preferences)
2. BUT Step function is empty! 
3. All generated code is Asynchrone 



END 59
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